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LIABILITY STATEMENT
The product, software or services are being provided on an “as is” and “as available” basis. Except
as may be stated specifically in your contract, ROKIT Healthcare expressly disclaims all warranties of
any kind, whether express or implied, including, but not limited to, any implied warranties of
merchantability, fitness for a particular purpose and non-infringement. You understand and agree
that ROKIT Healthcare shall not be liable for any direct, indirect, incidental, special, consequential
or exemplary damages, including but not limited to, damages for loss of profits, goodwill, use, data
or other intangible losses (even if ROKIT Healthcare has been advised of the possibility of such
damages), resulting from:
(i) the use or the inability to use the product or software;
(ii) the cost of procurement of substitute goods and services resulting from any products, goods,
data, software, information or services purchased;
(iii) unauthorized access to or alteration of your products, software or data;
(iv) statements or conduct of any third party; (v) any other matter relating to the product, software,
or services.
The text and drawings herein are for illustration and reference only. The specifications on which
they are based are subject to change. ROKIT Healthcare may, at any time and without notice, make
changes to this document. ROKIT Healthcare, for itself and on behalf of its subsidiaries, assumes no
liability for technical or editorial errors or omissions made herein, and shall not be liable for
incidental, consequential, indirect, or special damages, including, without limitation, loss of use, loss
or alteration of data, delays, or lost profits or savings arising from the use of this document.

COPYRIGHT STATEMENT
The content, organization, graphics, design, compilation, magnetic translation, digital conversion
and other matters related to the information in this document are protected under applicable
copyrights, trademarks and other proprietary (including but not limited to intellectual property)
rights. The copying, redistribution, use, reuse or publication of any part of the document without
advance notice to and approval from ROKIT Healthcare is strictly prohibited.

1. SAFETY INSTRUCTIONS
The following safety instructions are given to ensure user safety and prevent damage of the printer
as well as any accessories. Review the entire manual and use the printer properly before you start
AEP. The following symbols are used to indicate risk of equipment damage or personal injury.
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WARNING

CAUTION

The following instructions prevent safety hazards that could potentially result
in death and serious personal injury.
The following instructions prevent safety hazards that could potentially result
in equipment damage

Safety Instructions Related to Installation

CAUTION




Keep or install the AEP printer out of reach of children or infants


If children wear a power cable around their neck, it can cause choking.



If children turn on or touch the equipment incorrectly, it may cause a safety accident.

Install and use in well-ventilated areas.






Hazardous gases may be generated in the process of extruding filaments.

Use the power supply according to the AEP printer specification.


Improper use of electricity can cause shocks, damages, burns or fire



Use an outlet that matches the electrical capacity of the equipment and the accessories



If multiple pieces of equipment are provided, connect to a separate outlet for each device.

Do not install near hot air balloons and heat-sensitive materials, or in areas where there are
moisture, oil, dust, directly sunlight, water (rain, etc), or gas leaks or flammable materials.


There is a risk of electric shock, fire or explosion.

О Install the AEP printer on a strong, flat floor, ensuring it is grounded to the floor.



Abnormal vibration and noise can cause equipment failure.

Install with the guide of a trained professional technician.


Incorrect installation may cause electric shock, fire, failure, explosion or injury.
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Safety Instructions Related to Operation

WARNING


Never place your fingers near the machine until all parts have stopped moving. Moving parts
can cause injury.



The AEP series 3D printers generate high heat. Always wear gloves and, if reaching inside the
printer, wait until the printer’s been cooled down.



Never place your fingers near the machine until all parts have stopped moving. Moving parts
can cause injury when the printer is damaged or got strong impact..




When equipment malfunctions, it can cause personal injury

Stop using AEP printer immediately if there are any smokes, strange smells or an abnormal
operation of the equipment.



Do not use organic solvents such as benzene or thinner to clean the equipment. If you clean
with alcohol, use the equipment after the alcohol is completely dry.



Do not spray flammable sprays, such as paint, insecticide, or fragrance, on the AEP printer.



Do not use or store temperature-sensitive products such as flammable sprays, burning materials,
dry ice, medicines, or academic materials near the AEP printer. Also, do not store volatile or
flammable objects or materials (benzene, thinner, propane gas, etc.) or electrical appliances.



Keep water, other liquids, and foreign objects out of the equipment.


If water, other liquids, or foreign objects get inside, it may cause equipment breakdown,
electric shock or fire.




If water, other liquids or foreign objects get inside the unit, contact a service center.

Do not touch the equipment or power plug during a storm.


There is a danger of electric shock or fire. Stop use and keep your distance from the
equipment.



Do not touch the power cord with wet hands



Keep water, soil and metal objects away from the power plug.



Protect the power cord from damage



Connect the power plug firmly to the end of the outlet. Do not use a damaged power plug,
power cord or a loose outlet.



Never disassemble, repair or remodel on your own.

CAUTION


Remove the power plug when cleaning the equipment.




It may cause electric shock or fire.

Do not spray water directly on the product or wipe it with benzene, thinner, etc.


It may cause electric shock or fire due to short circuit.



The product may become discolored or the coating may come off.
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Do not wipe with a damp cloth.




It may cause electric shock or fire due to short circuit.

After cleaning, check to make sure the power cord is not damaged or overheated, and that the
plug is securely inserted.



Avoid use in places exposed to direct sunlight, high heat, or extreme cold.



Avoid using in places with high vibration.



Do not use excessive force to push or tilt the AEP printer.


It may cause injury or damage the floor.



Use AEP printer only for prototype production.



Use only 3D printing materials provided with the AEP Series 3D Printer from ROKIT Healthcare
or materials approved by ROKIT Healthcare.


Using unapproved materials may result in poor print quality or printer failure, in which case
ROKIT Healthcare will not support any repairs
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2. ABOUT THE AEP SERIES
2.1 AEP II Components
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2.2 AEP450 Components

1

5

2

5

6

1. Emergency Switch
2. LCD Screen
3. Extruder + Top

3

4. Bed
4

5. Cooling Fans (x3)
6. Chamber Control Fan
7

8

7. Power Switch
5

8. Power Supply Cable
9. Top Door Handle
10.Top Door Lock

BACK

FRONT

11.Heating Fans
12.Connection Ports
13.Bowden Block

9

14.Filament Holder

16

15.Front Door

10

16.Top Door
13

1

12
4
15
11

14

TOP
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2.3 AEP II Specifications
CATEGORY
Printing Method

AEP II SPECIFICATIONS
Fused Filament Fabrication (FFF)
230 mm x 200 mm x 200 mm

Build Volume

Build volume may be subject to filament type and object shape
~max 60 mm / sec

Printing Speed
Resolution
Supported File Formats

Speed may be subject to filament type and object shape
XY 6 um, Z 2.5 um
STL, OBJ, AMF

Supported PC

Windows 7 and over (Mac is not supported)

Auto-Leveling

O

Front Door sensor

O

Pause/Re-Start

O

Material Exchange
During Use

O

Filament Warmer

Built-in dehumidifier

Chamber Warmer

O

Printer Dimensions

540 mm X 410 mm X 810 mm

Printer Weight

60 kg

Extruder Nozzle

Single, 0.4 mm

User Interface
Extruder Nozzle
Temperature

WiFi / USB 2.0 Memory Card / USB 2.0 Cable
High-Temperature : ~ 430 ℃, Low-Temperature : ~250℃

Bed Temperature

~ 160 ℃

Top Bed Temperature

~ 100 ℃

Applicable Materials
Optional Extruder Set
Power
LCD
Required Conditions
Certification

ULTEM™ 9085, ULTEM 1010, PEEK, PLA, ABS, PC
“High-Temperature Extruder”: ULTEM™ 9085 / PEEK, ULTEM™ 1010
“Low-Temperature Extruder”: PLA / ABS / Low Temp PC
220 VAC Single Phase, 50/60 Hz 8.0A
7 inch (1260 x 800) Color LCD Touch Screen
Temperature 20 ~ 25 °C; Relative humidity 30 ~ 60 %
KC, CE, FCC

"ULTEM™ is a registered trademark of SABIC or its affiliates or subsidiaries." Specifications may be
AEP-CHS-20191117
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subject to change for improvement without notice.
2.4 AEP450 Specifications
CATEGORY
Printing Method

AEP 450 SPECIFICATIONS
Fused Filament Fabrication (FFF)
400 mm x 400 mm x 400 mm

Build Volume

Build volume may be subject to filament type and object shape
~ max 60 mm / sec

Printing Speed
Resolution
Supported File Formats

Speed may be subject to filament type and object shape
XY 6 um, Z 2.5 um
STL, OBJ, AMF

Supported PC

Windows 7 and over (Mac is not supported)

Auto-Leveling

O

Door sensor
Pause/Re-Start
Material Exchange
During Use

O (Top door, front door)
O
O

Filament Warmer

Built-in dehumidifier

Chamber Warmer

O

Printer Dimensions

810 mm x 720 mm x 1130 mm

Printer Weight

150 kg

Extruder Nozzle

Single, 0.4 mm

User Interface
Extruder Nozzle
Temperature

WiFi / USB 2.0 Memory Card / USB 2.0 Cable
High-Temperature : ~ 430 ℃, Low-Temperature : ~250℃

Bed Temperature

~ 160 ℃

Top Bed Temperature

~ 100 ℃

Applicable Materials
Optional Extruder Set
Power
LCD
Required Conditions
Certification
AEP-CHS-20191117

ULTEM™ 9085, ULTEM™ 1010, PEEK, PLA, ABS, PC
*High-Temperature Extruder”: ULTEM™ 9085 / PEEK, ULTEM™ 1010
“Low-Temperature Extruder”: PLA / ABS / Low Temp PC
220 VAC Single phase, 50/60 Hz 30A
7 inch (1260 x 800) Color LCD Touch Screen
Temperature 20 ~ 25 °C; Relative humidity 30 ~ 60 %
KC
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"ULTEM™ is a registered trademark of SABIC or its affiliates or subsidiaries." Specifications may be
subject to change for improvement without notice.
2.4 Accessories
The AEP series is provided with the following basic accessories:


USB Cable



Power cable: 220V



Dongle : WiFi connection



USB Memory



3 types of hex wrenches: 1.5mm, 2mm, 2.5mm



Scraper



1.8mm pin



Pinset



Adjustable Wrench:



Brush



Gloves



Low-temperature Extruder



Tool bag



Filaments: ULTEM™9085 1 Roll, PLA 1 Roll

3. GETTING STARTED
CAUTION


Always wear gloves to prevent burns.



Check if the power supply is connected correctly to product specifications.



Check if the AEP SERIES body works normally.



Make sure an original filament is equipped well.



Keep the bed surface clean.



At the start, perform manual bed-leveling.



Check the AEP SERIES is set to the desired setting.



Make sure the AEP SERIES main body has reached the desired setting. It is recommended to
warm up the equipment 30 minutes in advance before printing



To operate printing on a PC, install NewCreatorK on the PC and connect with AEP SERIES. PC
and AEP SERIES can be connected by USB cable or Wi-Fi.



Press the LCD button slowly. If you keep pressing the LCD button repeatedly, it may malfunction.

AEP-CHS-20191117
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WARNING


Use in well-ventilated areas.




Hazardous gases may be generated as the material for 3D printing melts.

Use the power supply according to the product specification.


Improper use of electricity may cause equipment failure, electric shock or fire.



Use an outlet that matches the electrical capacity of AEP SERIES provided including the
accessories.



If multiple devices are provided, connect to a separate outlet for each device

4. LCD TOUCH SCREEN
4.1 Home Screen
When you power on the system, the following pane opens.

4

5

2
1
-

3

To access the main screen, tap the "Menu” icon on the right side of the home screen.
1.

Back Button: Go to the previous step.

2.

Home Button: Go to the home screen.

3.

Multi Window: Indicates the APP currently running. You can change the APP or turn it
down.

4.

Wi-Fi Image: Displays the Wi-Fi connection status.

5.

Application Menu Icon: Go to the application menu which contains the NewCreator K app.
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4.2 Main Screen

-

New Creator K: Click and open APP to control all printer tasks and parameters. The most
frequently used APP.

-

Setting: Change the general settings of your hardware or connect to Wi-Fi

4.3 NewCreatorK APP Menu Screen

In order to operate the hardware normally, check the [StealthAEP: Operational] status on the top
bar of the screen before operating.
-

[File Print]: Check and move files in internal storage or USB storage, run the output file.

-

[Printer View]: Check the operation status of the printout and check the overall settings.

-

[Bed Leveling]: Set standard leveling

-

[Filament]: Filament replacement and loading before printing.

-

[Setting]: Change the default settings for printing

AEP-CHS-20191117
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4.4 Wi-Fi Connection
1. Press [Setting] from the main screen. In [Setting],
change the general settings of the hardware.

2. In [Setting], select the Wi-Fi network under
settings to turn Wi-Fi on in the [On/Off] Slider.

3. List of available Wi-Fi servers appears.
Top right button description
- [On/Off] slider: Turn On/Off Wi-Fi connection.
- [Refresh]: Refresh the screen
- [+]: Add hidden Wi-Fi network
- [Advanced Settings]: display Wi-Fi Scan, WPS, etc
which is advanced.
4. [Advanced Setting] Press the button and click the
name of the Wi-Fi network to add it.

5. Enter the server’s password to connect. (Only
password protected servers are compatible with the
printer.)
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6. The word “Connected” and the Wi-Fi icon in the
upper right corner of the screen indicated that the
printer has successfully connected to the Internet.

7. Click on the Wi-Fi connection server and the IP
address will appear. Remember that the IP address is
the address that will enter the New Creator K
software on your PC.

AEP-CHS-20191117

15

5. FILE PRINT
This screen allows you to select file for printing or to delete a file.

-

[Printer]: You can check the files stored in the internal memory. Internal capacity is 1.6G

-

[USB]: When you connect a USB drive, you can see the files stored on the USB

 Notice
1. Only files with the extension G-CODE can be listed.
2. Some USB drives are not recognized, depending on the type of USB drive.
In that case, you can use it after formatting or change to FAT32.
3. When you print a USB file, it is automatically copied and saved in the internal storage.
4. Files larger than 1.5G cannot be printed. Please use the split output, reduce the size, or
reduce the image resolution.
5. When saving a file wirelessly, the file may be broken or not saved depending on the
communication status.
6. When you start printing, you will be automatically moved to the view tap.

AEP-CHS-20191117
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5.1 Printing STL files
1. Tap the file to be printed. A pop-up confirm
message appears.

2. When [CONFIRM] is pressed, printing will start.
The LCD screen moves back to the initial screen.
When [CANCLE] is pressed, the LCD screen returns to
the previous screen.

5.2 Deleting a file

1. Tap the three dots on the right side. A pop-up
confirm message appears.

2. Press [CONFIRM] to delete the file permanently.

AEP-CHS-20191117
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6. PRINTER VIEW
6.1 Left screen

-

[STEALTH_AEP: Printing]: It indicates the printer status (i.e during printing, when an error occurs
or the printer is paused etc.).

-

Printing in progress: The green bar depicts the percentage of printing progress.

-

[START]: Reprints the file that was paused or has been completed.

-

[STOP]: It cancels printing.

-

[PAUSE]: It pauses printing. (Press [PAUSE] when the filament needs to be replaced )

-

[Bed]: It shows the bed temperature.

-

[Extruder 1]: It shows the extruder 1 temperature.

-

[Top]: It shows the top bed temperature.

-

[Inner Temp]: It shows the top bed temperature inner.

AEP-CHS-20191117

18

6.2 Motion
Use this menu screen while scrolling down.

-

[Motor]: It turns the motor on / off. (It controls X, Y, Z axis and extruder simultaneously.)

-

[Fan]: It turns the extruder fan on / off.

-

[X/Y home]: It moves to the starting point of the X and Y axis.

-

[X/Y Arrow]: The X and Y axis are moved in the direction of arrows.

-

[Z home]: It moves to the starting point of Z axis.

-

[Z Arrow]: The Z axis is moved in the direction of arrows.

-

[Length]: It moves the X, Y and Z axis to the desired length of 0.1mm ~ 100mm.

AEP-CHS-20191117
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6.3 Nozzle (Filament Loading/Unloading)
Use this menu screen while scrolling down.

-

[Extuder 1]: It selects the nozzle types.

-

[Loading]: It loads the filament.

-

[Unloading]: It unloads the filament.
* Notice: The material must be heated up to the suitable temperature.

- [Speed]:

It sets the speed of filament loading during the printing process.

-

[Distance]: It sets the length of filament loaded per click of the button.

-

[Extuder 1]: It selects the nozzle types

-

[Loading Speed]: It sets the speed at which the filament is loaded during the loading process.

-

[LOAD]: It loads the filament at [Loading Speed].
*

Tip: 3 mm/s is recommended in general. 25 mm/s is recommended when the filament

is being replaced.
-

[UNLOAD]: It unloads at [Loading Speed].

-

[PAUSE]: It pauses loading or unloading

AEP-CHS-20191117
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* Tip: [LOAD], [UNLOAD], [PAUSE] are used to load / unload continuously.
6.4 Temperature

AEP-CHS-20191117
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-

[Bed]: It sets the bed plate temperature.

-

[Extruder 1]: It sets the nozzle temperature.

-

[Top]: It sets the top bed temperature.
* Tip: The temperature can also be adjusted during printing.

-

Press the numeric field next to [Set to] in order to set the suitable temperature. Then, the
temperature setting box pops up.

-

After setting the temperature, click [ENT] and the temperature value next to [Set to] is updated.

-

Pressing the [SET] button changes the temperature values next to [Bed], [Extruder 1], and [Top
Bed].

7. BED LEVELING
7.1 Standard Levelling
Standard Leveling is used when the initial bed level position has been altered and it is difficult

-

to apply auto leveling.
-

Manually level the bed plate.

-

For more information, please refer to '10. 1 Standard Leveling'

AEP-CHS-20191117
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8. FILAMENT
8.1 Left Screen
The left screen shows the current temperature of Extruder 1 and this temperature value can be
changed..
1. [Temperature]: The left indicates the current
extruder temperature, and the right indicates the
set temperature.
2. To set the temperature value, click the
numeric field next to [Set to]. A number pad
appears for setting the temperature.

3. After setting the temperature, click the [ENT]. The
set temperature is shown next to [Set to].
4. Click the numeric field again. The set temperature
next to [Temperature] is updated.

AEP-CHS-20191117
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8.2 Right Screen
This section contains the same information as the section 6.3 Nozzle (Filament
Loading/Unloading.
Navigate this screen by scrolling.

-

[Extuder 1]: It selects the nozzle types.

-

[Loading]: It loads the filament.

-

[Unloading]: It unloads the filament.
* Notice: The material must be heated up to the suitable temperature.

- [Speed]:

It sets the speed of filament loading.

-

[Distance]: It sets the length of filament extruded per click of the button.

-

[Extuder 1]: It selects the nozzle types

-

[Loading Speed]: It sets the speed of filament loading.

-

[LOAD]: It loads the filament at [Loading Speed].
*

Tip: 3 mm/s is recommended in general. 25 mm/s is recommended when the filament

is being replaced.
-

[UNLOAD]: It unloads at [Loading Speed].

-

[PAUSE]: It pauses loading or unloading

AEP-CHS-20191117
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* Tip: [LOAD], [UNLOAD], [PAUSE] are used to load / unload continuously.

9. SETTING
9.1 PRINTER

- The product name, product S/N, Mac Address, and Version can be checked.
- [Update]: The firmware can be updated via the NewCreator K software while the printer is
connected to the PC over Wi-Fi. If Wi-Fi is not operational, then update using a USB cable or
USB drive.
* Tip: The serial number contains the product model and information. Please do not manually
change it.

9.2 NETWORK
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- [WiFi Network]: The SSID, IP address or Mac address can be checked if the printer is wirelessconnected.
- [USB network]: Use the address 192.168.7.2 when the printer is connected to the PC with a USB
cable.

9.3 Factory Reset

-

[Model Name]: It indicates the product name

-

[Serial Number]: It indicates the serial number.

* Tip: Do not change the serial number as the serial number includes the model name and
information intrinsic to the product.

AEP-CHS-20191117
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-

[FACTORY RESET] is used to initialize all setting values.

-

Click [OK] on the pop-up message. It will reset all setting values. Please be cautious.

-

The printer should automatically reboot after 5 seconds.

9.5 Option
Navigate this screen by scrolling.

AEP-CHS-20191117
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-

[Language]: It sets the device language to be Korean or English.

-

[Auto Leveling]: It turns Auto Leveling on or off. Auto Leveling is available to set on NewCreatorK
on the PC as well.

-

[Door Sensor]: It turns the front door detection function on or off.

-

[Filament Warmer]: It turns the filament warmer function on or off.

-

[Filament Sensor]: It turns the filament detection sensor on or off.

-

[Chamber Heater]: It enables or disables the chamber heater. The chamber heater operates
automatically but in case of 'ENABLE', 'ON/OFF' can be set manually.
* Tip: Chamber Heater is only supported on AEP450.

-

[Door Lock]: It turns the door lock on or off. In case of "ENABLE", "ON / OFF" can be set
manually.
* Tip: Door Lock is only supported on AEP450.

10. PRINTING
Printing proceeds in the following order of steps:
1. Power on S/W and pre-heat
2. Bed plate leveling
3. Filament loading
4. Setting of printing parameters
5. Slicing and G-Code generation
6. Printing
10.1 Standard Leveling
-

This section “10.1 Standard Leveling” is an extension of section '7.1 Standard Leveling'.

-

Standard Leveling is used when the initial bed level position has been altered and it is difficult
to apply auto leveling.

* Tip: In general, Standard Leveling is not used (while auto leveling is working properly).
-

Manually adjust the bed plate level.
1. Click on ‘Bed Leveling’ on the main screen of
NewCreatorK.
2. Press the home button to center the nozzle.

3. Select Length 1mm and press the up arrow button to raise the bed closer to the nozzle.
AEP-CHS-20191117
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4. Select a length of 0.1 mm. Insert a piece of print-size paper between the bed and the nozzle,
slide it back and forth, and click the up and down arrow buttons of bed to align the spacing
between the nozzle and bed, as pictured below.

5. Select [OFF] in [Printer View]> [MOTION]> [Motor].
6. Manually place the extruder at each corner of the bed and adjust the gap between the nozzle
and the bed glass by adjusting the nuts under the bed. Repeat at least 2 times in the order of 1,
2, 3, and 4.
7. When the adjustment is complete, remove A4 paper and move the nozzle to the center to
ensure that the nozzle does not scratch the bed glass.
8. After all adjustments, move the LCD screen to the main screen.

10.2 Pre-Autoleveling
This step is done when the Extruder has been replaced or the autoleveling sensor has been remounted.
1.

Close the top lid of the printer.

2.

Run NewCreatorK on PC and connect to the printer via the [CONNECT] screen.

3.

Click the [Measure Probe Z Offset] button at the bottom of the Control window.
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4.

When the extruder moves to the center of the bed and stops, wait until the bed temperature
reaches 50 degrees and remains stable.

5.

When the bed temperature reaches 50 degrees, see the top of the control window and select
the minimum unit of Z axis movement as 0.1mm or 1mm. (Press the nozzle slowly while
checking moving distance of the bed, being careful not to hit the bed.)

6.

Click the Up button of Z-axis until the nozzle and bed are in contact.

7.

When the nozzle tip is close to the bed, adjust the Z axis movement unit to 0.1 mm and
fine-tune it. When it comes in contact with the bed, click the [Set Probe Z Offset] button.

IMPORTANT!! If you have a newly set Measure Probe, Auto leveling will only work if you click the
[Enabled] button and check [Print with Auto leveling].
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IMPORTANT!! If the bed is not level even after pre-autoleveling, [Thermal Expansion Bed Calibration]
must be reset. (The horizontal value of the bed may change slightly due to vibration or thermal
deformation of the product.)

AEP-CHS-20191117
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10.3
-

Thermal Expansion Calibration
This is used when autoleveling has bene applied but printing remains difficult due to the gap
between bed and nozzle in certain X and Y sections.

-

You should record the setting value before making changes so that you can restore it if
necessary.
1.

Run NewCreatorK on PC and connect to the printer via the [CONNECT] screen.

2.

Select the 20 mm calibration box in the NewCreatorK sample file. Make the image size 10
mm smaller from each side of the bed build size. Make the Brim line 20, and while printing,
optimize the correction value.

3.

At the bottom of the Control window, adjust the "Thermal Expansion Bed Calibration" value
for 4 places to correct the autoleveling error as follows.

From the front, the bed's 4 vertex positions are defined by the values a, b, c, and d.
BACK
A 0.1

B -0.1

C 0.1

D -0.1
FRONT

1.

Assuming the center is fixed, correct the autoleveling error by changing the values of
A and D or B and C.

2.

Observe the first layer output and set the correction value for the 4 vertex position
between the nozzle and the bed.

3.

You need to set the correction value so that value D goes down as value A goes up
and value C goes down as value A goes up.

4.

To reduce the gap between the nozzle and the bed, subtract the height you want to
reduce from the previously set value. To increase the spacing, add to the existing
value.

5.

Set the compensation value so that the sum of the two diagonal vertices is equal (A +
D = B + C).

6.

It is recommended to adjust the correction value within the range of 0.01 mm to 0.1
mm from the existing value.

Example 1) Given the setting value of nozzle and bed spacing as follows, to open the spacing
by 0.01mm at Point A and narrow the spacing by 0.02 mm at point C, set the correction value
AEP-CHS-20191117
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as follows:
1.

Set the correction value so that the “A + D = B + C” condition is met.

2.

To extend the spacing at point A 0.01 mm, add 0.005 to the existing value at point A
and subtract 0.005 to the existing value at point D

3.

To narrow the spacing at point C by 0.02 mm, subtract 0.01 from the existing value at
point C and add 0.01 to the existing value at point D.
A 0.1

B -0.1

A 0.105

B -0.09

→

Existing

Revised
C 0.1

D -0.1

C 0.09

D -0.105

Example 2) Given the setting value of nozzle and bed spacing as follows, to open the spacing
by 0.04mm at Point A and by 0.01 mm at point C, set the correction value as follows:

1.

Set the correction value so that the “A + D = B + C” condition is met.

2.

To extend the spacing at point A 0.04 mm, add 0.02 to the existing value at point A and
subtract 0.02 from the existing value at point D

3.

Add 0.005 to the existing value at point C and subtract 0.005 from the existing value at
point D to open the spacing at point C by 0.01 mm.

A 0.105

B -0.09

A 0.125

B -0.095

C 0.095

D -0.125

→

Existing

Revised
C 0.09

D -0.105

IMPORTANT!! In case of [RESET], '10.2 Pre-Autoleveling 'and '10.3 Thermal Expansion Bed
Calibration' should be executed in a proper order.
10.4 Filament Loading
1.

Place a filament bobbin in the filament holder

2.

Push the filament string through Guide Tube-A and until it reaches the Bowden block.

3.

Go to the printer’s LCD screen, click [Filament] > [Extruder1] > [2mm] followed by [LOAD].

4.

Check that the filament moves and is pulled up the tube at the click of LOAD. Once you
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see the filament move, modulate the speed between 2mm/s and 25 mm/s until there is
about 5 cm of the filament remaining at the upper end of the tube. Then, click PAUSE on
the LCD screen.
5.

Cut the end portion of the filament at a 45 degree angle with the provided filament cutting
tool.

6.

Mount the filament with the tube onto the extruder (onto the hole located at the top).

7.

On the LCD Screen, click [Printer View] > [Temperature] > [Extruder1] and set the extruder
temperature according to the recommended specification for each filament:


ULTEM™ 9085: 350 ℃



ULTEM™ 1010: 380 ℃



PEEK: 430 ℃

* Tip: PEEK and ULTEM 9085 can be used interchangeably in one extruder; however, make sure
to pre-heat the extruder to 380 ℃ during filament exchange to avoid nozzle clogging.
* Tip: In general, we highly recommend a practice of using one extruder for one material.
8.

Once the temperature starts rising on [Printer View] screen, start loading the filament at
a [Loading speed] of 2 mm

* Tip : When removing the filament extruded out of the nozzle, please use the tweezers
9.

Once the extruder has been heated to its set temperature, press LOAD at a speed of 2
mm/sec.

*Tip: When removing the filament extruded out of the nozzle, please use the tweezers
10. Once the filament load is complete, press PAUSE on the LCD screen and set the extruder
temperature back as guided in step 7.

10.5 Filament Removal and Cleaning
1.

Select [Filament] > [EXTRUDER 1] in LCD display.

2.

Preheat the solidified filament by raising the nozzle temperature in [Temperature]
window.

3.

Select [UNLOAD] in order to extract the filament out of the nozzle.

4.

After removing the tube while pressing onto the fitting on the nozzle, cut the tip at 45
degree angle.

5.

Disinfect the metal pin with alcohol, and then insert it into the nozzle to remove the
debris.
*TIP : Preserve the leftover filament bobbin in the closed package

6.

By selecting [Printer View] > [Temperature] > [Extruder] on LCD display, set the
temperature to 0℃

10.6 Creating G-CODE File
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- To prepare a file for print, convert the 3D object
to a g-code using NewCreatorK.
1. Run NewCreatorK installed on the PC.
2. Select the appropriate printer model by selecting
[Settings] > [Printer], located on the upper left corner.

3. Open the 3D object file by selecting [File] > [Open]
(stl, obj, amf).

4. On [OBJECT] tab, move, rotate, and modify
dimensions of the object.

5. On [SLICER] tab, set the printing parameters (i.e.
printing speed, extruder temperature, fill density %,
etc.) as appropriate.
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6. Click on the “slicing” button generates the g-code.
Save the file clicking “save”.



NewCreatorK can be downloaded from the homepage www.rokithealthcare.com.



For a detailed guide on NewCreatorK software operations, refer to the NewCreator K User
Manual.

10.7 Printing (4 Methods)


Print from an external USB hard drive
1.

Mount an external USB hard drive to the port located on the upper right-hand side of the
printer



2.

On the LCD display NewCreatorK Home Screen, click FILE PRINT > USB.

3.

Select the g-code file of your choice. The printer will start printing.

Print from PC using a USB cable
1.

Open the NewCreatorK software on the PC. Press the CONNECT icon on the orange
NewCreatorK icon menu.

2.

In the IP address box, enter 192.168.7.2 (default USB cable IP address). Press CONNECT.

3.

If connected properly, you will see the printer state to be “OPERATIONAL”. Use the UPLOAD
button to upload g-code files from the PC to the printer.



Print from PC using Wi-Fi
*Make sure that the printer is already connected to the Wi-Fi server.
1.

On the LCD display NewCreatorK Home Screen, click SETTING > NETWORK tab

2.

Identify the WI-FI NETWORK IP.

3.

On the NewCreatorK software on PC, go to [Connect] icon.

4.

In the IP address box (NewCreatorK software > CONNECT), enter the network IP address
192.168.0.XXX. Press CONNECT.

5.

If connected properly, you will see the printer state to be “OPERATIONAL”. Use the UPLOAD
button to upload g-code files from the PC to the printer.
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Print directly from the printer’s internal storage
1.

On the LCD display, click [File Print] > [Print].

2.

Identify files stored in the printer.

3.

Click on a file to print. A window will pop up.

4.

Click [Confirm] to start print.

Notes:
1.

Only .gcode files are viewable on the LCD screen when using the USB hard drive.

2.

For USB hard drives that do not get detected by the printer, you may need to re-format or
switch it to a FAT32 type to use.

3.

Files uploaded via a USB drive get copied and stored in the printer’s local drive as well.

4.

The size limit of each .gcode file is 1.5 gigabytes.

5.

An unstable Wi-Fi connection may cause files to get broken while being transferred over
from the PC to the printer. Ensure the printer is installed in a well-connected area.

FAQ & TROUBLE SHOOTING

[When the filament does not load]
-

Check the LCD display to make sure that the nozzle temperature is set appropriately for
the filament used (ULTEM™: 380 degrees, PEEK: 430 degrees) and that the difference
between the actual temperature and the set temperature is within 10°C.

-

If the nozzle temperature is normal, click the “Pause” button and set the nozzle
temperature 20°C higher than the currently set temperature, and start loading the
filament at a speed of 1 mm / s.

-

Clean the nozzle using the provided nozzle cleaning tool

-

If the nozzle temperature is not normal or cannot be solved by the above methods,
contact the after-sales service team.

-

Clean the nozzle with a dedicated cleaning tool before and after use.

[When the nozzle and bed distance need to be adjusted during printing]
-

To adjust the distance between the nozzle and the bed horizontal, change the “Thermal
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Offset” value and click the “Set Probe Z Offset” button to correct the gap between the
nozzle and the bed. (“Thermal Offset” is a relative value. The distance between the bed
and the nozzle is changed at a difference set by the “Thermal Offset” value. A positive
offset value leads to a greater gap between the bed and the nozzle, while a negative value
leads a closing of the gap.)
-

Run the NewCreatorK desktop version, connect to the printer and go to the “Control” tab
to check whether Auto Leveling is enabled.

-

If Auto Leveling is in the "Disable" state, click Reset button to initialize the leveling settings
and try again.

-

If you want to adjust only some corner height relative to the edge of the bed, adjust the
height of the bed by adjusting the four knobs at the bottom of the bed. The knob should
be adjusted so that the length of each spring supporting the bed is within the range of
18mm to 30mm.

-

Check that the Z limit sensor located at each Z-axis profile is properly fixed.

[When the pre-heat process lasts more than 1 hour after clicking the print start button]
-

If the front and upper doors of the printer are open, close them.

-

Check if the bed temperature, chamber internal temperature and nozzle temperature are
kept within 5 degrees from the set temperature value.

[When the object does not adhere to the bed]
-

Make sure the temperature outside the printer is in the range of 20 to 25°C.

-

Check if the chamber and nozzle temperature are kept within the set temperature range.

-

At the bottom of the print object, create and attach a “Cylinder”-shaped sample object at
a thickness of 0.254 mm (like a brim) so that any angled part of the print object
disappears.

-

Increase the “Brim Line Width” in the slicing setting value within the range of 20 to 30
mm. If using PEEK and ULTEM™ filaments, allow them to warm up sufficiently in the
oven to ensure a smooth surface without bubbles during loading tests.

[When the support structure collapses during printing]
-

Increase support usage on NewCreatorK

-

To widen the width x height area of the support structure, create an auxiliary structure and
insert beneath the object.

[When the surface quality of the print is poor or the tensile strength is weak]
-

The quality of the print can be categorized as tensile strength and surface quality, and it
is highly affected by the overall printing environment. Please keep the environmental
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temperature between 20 ~ 25°C. When using PEEK and ULTEM™, pre-warm them
sufficiently in the oven to ensure no bubble during loading tests and a smooth surface in
the finished product.
[Cautions while printing with ULTEM™ 1010]
-

ULTEM™ 1010 prints have strong adhesion to the glass bed, so if the bed or chamber
temperature drop sharply during printing, the print will be deformed and the equipment
will be less durable. Therefore, during printing, the door should be kept as closed as
possible and wait for the annealing process (which takes about 6 hours) to finish normally
after the output is finished.

-

Even if the printing is cancelled, the annealing process is required when the printed
materials are stacked in a larger area than 3 layers.

[When the nozzle or bed does not move]
-

Run the NewCreatorK desktop version, connect to the printer, go to the “Control” tab,
change the Motor setting from Off to On and check if it operates normally.

-

Click XY Home and Z Home button to move the bed and extruder the origin and check.

-

If the problem is not solved, reboot the equipment.

[Updating the firmware (F/W)]
-

Save the firmware file onto the PC where NewCreatorK is installed.

-

Run NewCreatorK and click the “Connect” button to connect to the device.

-

Go to the Print Info window and click the “Update” button.

-

When the file selection window appears, navigate to and select the saved F/W file
location.

-

Observe the green progress bar. The equipment will automatically reboot when the file
transfer is completed.

-

If 5 minutes has passed and booting is not completed and the LCD screen remains off,
power off the equipment manually and turn on.

[Updating the NewCreatorK software]
-

Extract the NewCreatorK update file provided and run the NewCreatorK_V * .exe file.

-

The PC with NewCreatorK installed can be updated without selecting “Python 2.7.6
Install” and “USB Driver (Invivo, AEP, Stealth Series)”.

-

Even if you install in the same location where NewCreatorK is installed, the existing
settings will not be erased or initialized.

[General preparation before printing]
AEP-CHS-20191117

39

1.

Raise the nozzle temperature to the filament loading temperature and clean the
inside of the nozzle with the provided 1.8 cleaning pin.

2.

Clean the outside of the nozzle with the cutting scissors and tweezers.

3.

Set the nozzle temperature to (a theoretical) 0°C, which drives the extruder to room
temperature.

4.

Clean impurities and grease on the bed glass plate with a glass cleaner.

5.

When the extruder has been replaced, connect to the instrument in NewCreatorK
and execute "Set Measure Probe" located at the bottom of the control window to set
the distance between the autoleveling sensor and the nozzle tip. Refer to [When the
extruder has been replaced].

6.

When the extruder is replaced, connect to the equipment in NewCreatorK and
execute "PID Tuning" located at the bottom of the Basic window to minimize the
temperature change of the nozzle. Refer to [When the extruder has been replaced].

7.

If the bed is twisted a lot, perform standard leveling using the LCD UI. Refer to
[Standard Leveling Method].

8.

Check that the filament has been pre-warmed sufficiently in the oven before use. The
resulting print from a filament loading test must have a smooth surface.

9.

In the case of PEEK and ULTEM® filaments, make sure to pre-heat in the oven to
remove any residual humidity.

10. To improve surface quality over tensile strength when printing with PEEK or ULTEM®,
it is recommended to set the line width ratio to be 100.
11. In the case of low-temperature filaments (i.e. exclude PEEK and ULTEM®), disable the
filament pre-warm settings. If not, the low-temperature filament may change
properties and lead to poor filament loading and print quality overall..
12. When printing with PLA, the bed heat may affect the overall heating up of the
chamber, leading to compromised print quality. Therefore, it is recommended to start
printing with the top door open. (In the case of ABS, chamber temperature control is
critical; please print with the top door closed.)

[Cautions when powering off the equipment]
Nozzle may get clogged when the power is turned off at a high temperature, so turn off the
equipment when the nozzle temperature is below 50°C.

[Points to check when printing is not on platform due to uneven bed]
1.

Make sure that the gap between the nozzle and the bed is uniform. Check with a piece
of print paper during standard leveling with the upper door closed.

2.

During standard leveling, start with all knobs tightened to the max and check the bed
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plate leveling by loosening a little at a time.
3.

Make sure the Autoleveling sensor is securely attached to the extruder.

4.

Check that the bolts on the bed are fixed with even torque.

5.

Make sure that all coins - 9 in the middle and 4 at the corner - are in normal positions
on the glass plate. (In Autoleveling, the sensor should be at the center of the coin, and
the left and right alignment is important like a checkerboard)

6.

With the bed temperature reaching the target temperature, check that the gap between
the glass plate and the bed remains even.

7.

When measuring Probe, check 3 times if Z axis Align is working properly. (Do this while
the keeping the upper door closed.)

8.

The upper door should be kept closed when Autoleveling.

[When the print keeps falling off the bed]
1.

First refer to the section [General preparation before printing]. Check all items before
moving onto the next step.

2.

While the first layer is printing, check the front door (if necessary, open the top door
within 10 seconds) to see if any of the following (subsections 2.1 – 2.8) occur and follow
appropriate troubleshooting instructions below:
-

Only when the first layer is printing, you can open the front door and the upper
door to check the status of printouts or remove unwanted filaments.

-

Do not open the front and upper doors as far as possible from the second layer. The
printout contracts and deformation may occur.

2.1 Filaments are discharged from the air due to a gap between the nozzle and bed
-

Decreasing the layer gap of the first layer improves layer adhesion. During printing,
adjust the thermal offset value at an increment of 0.05 ~ 0.15 mm units. Set the thermal
offset value so that the thickness of the printed material becomes 0.15 ~ 0.2 mm. The
Thermal Offset value adjusts the bed-nozzle spacing by a relative value. (It may be
negative number.) The gap between the nozzle and the bed widens with the increasing
value, and vice versa.

2.2 The lines making up the first layer are falling apart
-

Reduce the Thermal Offset value during printing at an increment of 0.05 mm to ensure
that lines making up the first layer are closer to each other as much as possible

-

When the brim has been printed at least 2 lines, remove it and check preliminarily that
the lines are well stuck together. If the brim is 10 lines or less, the adhesion may
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become weak. In the NewCreatorK setting, set the brimline to be larger than the
default setting of 20 so that the initial 10 lines can be used to check the line spacing.
-

If the lines do not stick together after adjusting the Thermal Offset, reduce the width
of the first layer line in 2-5% increments in the slicer settings.

2.3 When the lines making up the first layer are apart in select, fragmented areas of the print
-

The "Thermal Expansion Bed Calibration" value can be used to re-calibrate the bed if it
is tilted uneven. Set the correction value to raise or lower the bed plate at each of the
four corners in the range of 0.005 to 0.01 mm as you stand in front of the AEP front
door and look down on the bed. However, the sum of the two diagonal vertices must
be set equal.

-

Narrow the gap between the bed and the nozzle by adjusting the knobs close to the
problematic areas of the first layer.

2.4 Filament agglomerates outside the nozzle, scratching over the print on the bed.
-

The front door lock is unlocked during printing of the first layer (in AEP 450), so during
the first layer printing, open the door and remove filament ooze at the nozzle end. If the
filament ooze at the nozzle end comes off as the print is peeled off the bed, use the
Hera to clean the outside of the printing nozzle before re-printing.

2.5 Despite the successful printing of the first layer, the print falls off in later stages.
-

At the bottom of the print object, create and attach a “Cylinder”-shaped sample object at
a thickness 1.2 times greater than the layer thickness (like a brim) so that any angled part
of the print object disappears.

-

Any part on the first layer that has a black shadow is indicative of low layer adhesion to
the bed plate. Use the Thermal Expansion Bed Calibration to strengthen adhesion. (The
newly set value will be reflected in the next print result.)

2.6 Angled parts of the print fall of the bed
-

Angled parts have a greater stress that can lead the print to fall off the bed. Create and
attach a “Cylinder”-shaped sample object at a thickness 1-2 times greater than the layer
thickness (like a brim) so that any angled part of the print object disappears.

2.7 When a PEEK part swells and the print falls off
-

If the object file is of a shape that accumulates the bed heat, it is necessary to lower the
overall printing temperature. Lower the extruder temperature at an increment of 5°C until
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the print is optimized

2.8 If any change in bed temperature and Size of output, the Thermal Offset setting may
require adjustments.
[When the extruder has been replaced]
1.

Connect to the device by clicking the Connect button in NewCreatorK.

2.

Raise the temperature of the extruder to a temperature suitable for the filament material
and clean the nozzle surface.

3.

After setting the nozzle temperature to room temperature, wait until the temperature is
below 50°C.

4.

Run [Set Measure Probe] in the control window of NewCreatorK to prepare for using the
Autoleveling function. See section “Measure Probe Settings”.

5.

In the Basic window of NewCreatorK, execute [PID Tuning] so that the nozzle temperature
is kept at the set temperature stably. See section [PID Tuning].

[Measure Probe Settings]
1.

In NewCreatorK, click the [Connect] button to connect the device.

2.

Close the top lid of the equipment.

3.

In the [Connect] -> Control window, click "Set Measure Probe".

4.

Wait until the bed temperature reaches 50°C

5.

Once the extruder has reached the bed’s center, select the minimum Z-axis distance unit
between 0.1mm, 1mm, and 10mm.

6.

Click the Z-axis movement arrow until the nozzle touches the bed

7.

Once the nozzle has touched the bed, click "Set Probe Z Offset".

[PID Tuning]
3.

In NewCreatorK, click the [Connect] button to connect the device.

4.

At the bottom of the Basic window, enter the nozzle temperature of the material used in
the text box located to the right of [Show Cmd].

5.

Click the [PID Tuning] button.

6.

Repeat PID Tuning by repeatedly raising and lowering the nozzle temperature.

7.

When PID Tuning is completed, the message that “Tuning is completed “is displayed

[Product Quality]
1.

Measure Probe and PID tuning must be performed when the extruder is replaced or the
glass plate of the bed is remounted.
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2.

When changing the material of the printout, if the nozzle temperature set value is
different from the set temperature of the previous material, perform PID tuning again
according to the nozzle set temperature to maintain the surface quality of the printout.

3.

The geometry that can be printed without supporter improves the surface quality of the
printout by setting the fan cooling speed value by 30% more than the previous setting.
(NewCreatorK setting position: advanced setting-> cooling-> adjust the maximum speed
value)

[Warning]
1.

If the nozzle is left at high temperature for more than 10 minutes without the nozzle
loaded, the filament may burn and the nozzle may become clogged.

2.

If grease applied to X, Y, Z shaft and screw disappears, apply heat-resistant Teflon grease.
(Be careful not to contaminate the glass bed with grease.)

3.

When replacing the filament or removing the filament attached to the bed while the
equipment is warmed up, wear the provided gloves to avoid burns.

4.

Be careful of burns as the printer case may be hot while printing.

5.

In order to maintain the durability of the bed, preheat the bed to about 50 ℃ even if there
is no output on high humidity days.

6.

When outputting low-temperature materials (PLA, PC) with the internal temperature set to
0, open the front door so that the chamber temperature is maintained at about 20 ℃ ~
30 ℃. (If you print with the front door closed, the bed temperature may cause the chamber
temperature to rise, resulting in poor output quality.)

7.

Do not connect any other electrical equipment to the power outlet.

8.

Be sure to ventilate during long time printing or after finishing printing.

9.

Remove printouts using the provided scraper to prevent overstress when the bed
temperature drops below 50 ° C.

10. The printer should be used only by qualified personnel who have completed AEP SERIES
operational training.
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